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Chapter 1

Introduction

The T-Core presents a robust hardware design platform built around the Intel MAX 10 FPGA. The
MAX 10 FPGA is well equipped to provide cost effective, single-chip solutions in control plane or
data path applications and industry-leading programmable logic for ultimate design flexibility. With
MAX 10 FPGA, you can get lower power consumption / cost and higher performance. When you
need high-volume applications, including protocol bridging, motor control drive, analog to digital
conversion, and handheld devices, the T-Core MAX 10 FPGA is your best choice.

The T-Core development board includes hardware such as on-board USB Blaster II, QSPI Flash,
ADC-Header, WS2812B RGB LEDs and 2x6 TMD expansion header. By leveraging all of these
capabilities, the T-Core is the perfect solution for showcasing, evaluating, and prototyping the true
potential of the Intel MAX 10 FPGA.

T-Core also supports RISC-V CPU with on-board JTAG debug, it is an ideal platform for learning
RISC-V CPU design or embedded system design.

1.1 Package Contents

Figure 1-1 shows a photograph of the T-Core package.

o T-Core board
© Mini USB Cable
€© Fiat Ribbon Cable

Figure 1-1 The T-Core package contents
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The T-Core package includes:
¢ The T-Core board
¢ USB Mini-B Cable
e Flat Ribbon Cable

1.2 T-Core System CD

The T-Core System CD contains the documentation and supporting materials, including the User
Manual, reference designs and device datasheets.

User can download this System CD from the web (http://T-Core.terasic.com/cd).

1.3 Layout and Components

This section presents the features and design characteristics of the board.

A photograph of the board is shown in Figure 1-2 and Figure 1-3. It depicts the layout of the board
and indicates the location of the connectors and key components.
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Figure 1-2 Development Board (top view)
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MAX10/RISC-V JTAG Config
Figure 1-3 Development Board (bottom view)

This board has many features that allow users to implement a wide range of designed circuits, from
simple circuits to various multimedia projects.

The following hardware are provided on the board:

FPGA Device

e MAX 10 10M50DAF484C7G Device

e Integrated dual ADCs, each ADC supports 1 dedicated analog input and 8 dual function
pins

¢ 50K programmable logic elements

¢ 1,638 Kbits M9K Memory

5,888 Kbits user flash memory

e 144 18 x 18 Multiplier

o4 PLLs

Programming and Configuration

e On-Board USB Blaster II (Mini USB connector)

Memory Device

¢ QSPI Flash (Support RISC-V)
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Connectors

¢2x6 TMD GPIO Header
¢ 1x10 ADC Header
¢ WS2812B RGB LED Expansion Header

Switches, Buttons and LEDs

o4 Green LEDs
¢4 Dip Switches
¢ 2 Push Buttons with Debounced.

¢4 WS2812B RGB LED

Power
¢ 5V DC input from USB or external power connector.
1.4 Block Diagram of the Board
Figure 1-4 gives the block diagram of the board. To provide maximum flexibility for the user, all

connections are made through the MAX 10 FPGA device. Thus, the user can configure the FPGA to
implement any system design.

T

ws2812B

MAX10/RISC-V
DIP x2 JTAG Enable/Disable ddsezent

s

7 JTAG _ I
press g
RISC-V f QSPI

JTAG { Flash
(RISC-V)

KEY x2
SWITCH x4

Figure 1-4 Board Block Diagram
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1.5 Getting Help

Here are the addresses where you can get help if you encounter any problem:
e Terasic Inc.
*OF., No.176, Sec.2, Gongdao 5th Rd, East Dist, Hsinchu City, 30070. Taiwan
e Email: support@terasic.com
o Tel.: +886-3-5750-880

e Web: http://T-Core.terasic.com
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Chapter 2

Using the T-Core

This chapter provides instructions to use the board and the peripherals description.

2.1 Configuration of MAX 10 FPGA on T-Core

There are two types of configuration method supported by T-Core:
1. JTAG configuration: configuration using JTAG port.

JTAG configuration scheme allows you to directly configure the device core through JTAG pins -
TDI, TDO, TMS, and TCK pins. The Quartus Prime software automatically generates .sof files that
are used for JTAG configuration with a download cable in the Quartus Prime software program.

2. Internal configuration: configuration using internal flash.

Before internal configuration, you need to program the configuration data into the configuration
flash memory (CFM) which provides non-volatile storage for the bit stream. The information is
retained within CFM even if the T-Core board is turned off. When the board is powered on, the
configuration data in the CFM is automatically loaded into the MAX 10 FPGA.

B JTAG Chain on T-Core Board

Figure 2-1 shows the JTAG interface of T-Core board, which uses the USB Blaster II (UB2) circuit
to connect to the host PC. The JTAG interface of the T-Core board can be divided into common
FPGA configuration and RISC-V applications. Users can configure or debug the MAX10 FPGA on
the T-Core through the UB2 interface and Quartus software on the host PC. You can also use the
UB2 circuit to download the binary file from the host PC to RISC-V application. The two position
switches on the SW2 can control whether the MAX10 FPGA and RISC-V application will appear in
the JTAG chain of the T-Core board.
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PC MAX10

" e
USB — uB2

— Connector

. ' MAX10 IO PIN
Open On-Chip Debugger <+—> (RISC-V JTAG PIN)

MAX10 JTAG Enable/Disable DIP x2 QSPI Flash
RISC-V JTAG Enable/Disable (RISC-V)

Figure 2-1 The JTAG configuration scheme

Figure 2-2 The JTAG Switch for MAX10 FPGA and RISC-V

Figure 2-2 shows the factory settings of the SW2. The SW2.1 position is used for enable/disable
the MAX 10 FPGA in the JTAG chain. When set to ON, the MAX10 FPGA will appear in the
JTAG chain of T-Core. SW2.2 is the JTAG chain switch for RISC-V applications. If it is turned off,
the application will not appear in the JTAG chain. For more information about the RISC-V
application, please refer to section 3.5 for more information.

Table 2-1 is the setting of SW2 and its function.

www.terasic.com

Table 2-1 MAX10 and RISC-V JTAG Chain setting for SW2
SW2 Position

SW2Position [
\ MAX10 (SW2.1) RISC-V (SW2.2)

MAX10 and RISC-V off chain
OFF ON MAX10 off chain and RISC-V on chain
ON OFF MAX10 on chain and RISC-V off chain
ON ON MAX10 on chain and RISC-V on chain
T-Core 8 www.terasic.com
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B Configure the FPGA in JTAG Mode

The following shows how the FPGA is programmed in JTAG mode step by step.

1.  Open the Quartus Prime programmer, please choose Tools > Programmer. The Programmer
window opens. See Figure 2-3.

O3 Programmer - G:/tmp/T-core/cd/Demonstration/Default/T_CORE_Default - T_CORE_Default - [T_CORE_Defau..... — O >

Eile Edit View Processing Tools Window Help

:..HardwareE.etup... T-Core [USBE-1] Mode: | JTAG A Prugress:’ ]

[ Enable real-time ISP to allow background programming when available

0 e File Device Checksum Usercode Program/  Werify = Blank- Examine
Start

Configure Check

i Stop

M suto Detect
Delete

Y add File...

£ >
s Change File...

ol Save File
= Add Device...

i Down

Figure 2-3 Programmer Window

2. Click “Hardware Setup”, as circled in Figure 2-3.

3. If it is not already turned on, turn on the USB-Blaster [USB-0] option under currently selected
hardware and click “Close” to close the window. See Figure 2-4.
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4,

5.

4 Hardware Setup

Hardware Settings JTAG Settings

Select a programming hardware setup to use when programming devices. This programming

hardware setup applies only to the current programmer window.

Currently selected hardware: | | T-Core [USBE-1]

Available hardware items

Hardware Server Fort | Add Hardware... |

UsSE-1

T-Core Local
Rermowve Hardware

Close

Figure 2-4 Hardware Setting

Click “Auto Detect” to detect all the devices on the JTAG chain, as circled in Figure 2-5.

O Programmer - G:/tmp/T-core/cd/Demaonstration/Default/T_CORE_Default - T_CORE_Default - [T_CORE_Defau.....

File Edit View Processing Tools Window Help

Mode: | JTAG hd Progress:

5 Hardware Setup... | T-Core [USB-1]

[ Enable real-time ISP to allow background programming when available

File Device Checksum Usercode Program/  Verify  Blank- Examine

b gtart
Configure Check

to Stop

M Auto Detect

Delete

™ Add File...

ar Change File...
dh save File
F" Add Device...
' up

o Down

Figure 2-5 Detect FPGA device in JTAG mode

Select detected device associated with the board, as circled in Figure 2-6.
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4 select Device >

Found devices with shared JTAG ID for device 1. Please select your device.

(® 10M50DA

) 10Ms0DAES

) 10Ms0DC

OK
Figure 2-6 Select 10MS0DA device
6. FPGA is detected, as shown in Figure 2-7.
B Programmer - G:/tmp/T-core/cd/Demaonstration/Default/T_CORE_Default - T_CORE_Default - [T_CORE_Defau..... — O
Eile Edit View Processing Tools Window Help Search altera.com
.?- Hardware Setup...| (T-Core [USBE-1] Mode: | JTAG g Progress: ’
[ Enable real-time ISP to allow background programming when available
% gtart File Device Checksumn Usercode Program/  Werify = Blank- Exarmnine
al
Configure Check
h stop <nones 10M50DA 00000000 <nones [l l
M auto Detect
Delete
™ addFile..
ar Change File... <
k) Save File
I'* Add Device . e
TCH E E
B |[—— E—
TEI’DDWH ....------.
TOMS50DA
TDO
4
Figure 2-7 FPGA detected in Quartus Prime programmer
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7. Right click on the FPGA device and click “Change File” to open the .sof file to be
programmed, as highlighted in Figure 2-8.

B Programmer - G:/tmp/T-core/cd/Demonstration/Default/T CORE_Default - T_CORE_Default - [T_CORE Defau... — O >
File Edit WView Processing Tools Window Help [ P ‘.
¥ Delete Del —_——
:.3. Hardware Setup...| [T-Core [USB-1] Mode: | JTAG Select All Ctri+A
[] Enable real-time ISP to allow background programming when available M Add File..
1% Change File I
P oot File Device Checks % S Eila k- Exarnine
ck
#b stop <none> 10M50DA e O
T = Change [PS File...
M Auto Detect _
. Delete IPS File
g et Add EKP File..
| M addFile.. | Change EKP File..
| Delete EKP File
g.p- Change File...| ! i
= Add PR Programming File... £
:.E“" Save File
Change PR Programming File...
™ Add Device... | | A e Delete PR Programming File
— i L] -
TDI E I
il Up —> Ci— Attach Flash Device...
i E Edit FI Change Flash Device...
+ % Down I_ERRuE 2
o Show Device's Properties Delete Flash Device
TDO
4 | F*  Add Device..
v
Change Device
Replaces a selected programming file

Figure 2-8 Open the .sof file to be programmed into the FPGA device

8.  Open the “output_files” folder and select the .sof file to be programmed, as shown in Figure
2-9.
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& select New Programming File >
Look in: G:\tmp\ T -core\cd\Demanstration\ Default\output_files A 0 (5] 0 @ E]
W iy Comp... || || T_CORE_Default. pof
D T _CORE_Default sof
a User = =
File name: |T_CORE_De‘fault.sof | | Open
Files of type: | Programming Files [*.sof *. pof *.jam *.jbc *.ekp * jic) hd Cancel

Figure 2-9 Select the .sof file to be programmed into the FPGA device

9. Click “Program/Configure” check box and then click “Start” button to download the .sof file
into the FPGA device, as shown in Figure 2-10.

& Programmer - G./tmp/T-core/cd/Demaonstration/Default/T_CORE_Default - T_CORE_Default - [T_CORE_Defau... — a X
Eile Edit ¥iew Processing Tools Window Help Search altera.com "
; Hardware Setup...| [T-Core [USBE-1] Mode: | JTAG B Progress: ’ ]
[] Enable real-time ISP to allow background programming when available
wh geart File Device Checksum Usercode Program/ | WVerify  Blank- Exarnine
Configure Check
b Stop output files/T CORE .. TOMSODAF484 00410D18  00470D18
M auto Detect
X Delete
™ AddFile.. |
F"ﬂ Change Fil?...; ul 2
-
Bl save File
P idd Device- | [pocesswces:
— — L] L
TOI b
N <
L] L
L] -
fTEu Dawn ?_J_I.llllj_l.l__-:
10M50DAF484
TDO
4
¥
Figure 2-10 Program .sof file into the FPGA device
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B Internal Configuration

¢ The configuration data to be written to CFM will be part of the programmer object file (.pof).
This configuration data is automatically loaded from the CFM into the MAX 10 devices when

the board is powered up.

ePlease refer to Chapter 4: Programming the Configuration Flash Memory (CFM) for the
basic programming instruction on the configuration flash memory (CFM).

MAX 10 Device -1
CRAM

Internal

JTAG Configuration

In-System : \
Programmin : l

Figure 2-11 High-Level Overview of Internal Configuration for MAX 10 Devices

B Status LED

The T-Core development board includes board-specific status LEDs to indicate board status. Please
refer to Table 2-2 for the description of the LED indicator. Please refer to Figure 2-12 for detailed
LED location.

§. _«.—.,.‘......-=_—::=ﬁ:=='r5§::fn%‘ 2 LE D6
: G 5| LED5
E LED4
D3
Figure 2-12 Status LED position
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Table 2-2 Status LED

Reference | LED Name Description
LED4 JTAG RX llluminate when data is transferred from USB Host to JTAG.
LED5 JTAG TX llluminate when data is transferred from JTAG to USB Host.
LEDG6 CONF_DONE llluminates when the FPGA is successfully configured.
LED7 Status llluminates Bard status
D3 5V llluminates when Input power is active. Not Installed.
D4 Power Good llluminates when board power system is OK.

2.2 Clock Circuitry

Figure 2-13 shows the default frequency of all external clocks to the MAX 10 FPGA. A clock
generator is used to distribute clock signals with low jitter. The two S0MHz clock signals connected
to the FPGA are used as clock sources for user logic. One 24MHz clock signal is connected to the
clock inputs of USB microcontroller of USB Blaster. One 10MHz clock signal is connected to the
PLL1 and PLL3 of FPGA, the outputs of these two PLLs can drive ADC clock. The associated pin
assignment for clock inputs to FPGA I/O pins is listed in Table 2-3.

Warning!!
Do not modify the clock generator settings.

Incorrect setting will cause the system to not work.

Clock Generator
2 P
24MHz . : :
. ADC_CLK_10 4 mm
MAX10_CLK1_50 .
> P11 %
MAX10_CLK2_50 8y
> N14 T

Figure 2-13 Clock circuit of the FPGA Board

Table 2-3 Pin Assignment of Clock Inputs

ADC_CLK_10 PIN_N5 10 MHz clock input for ADC (Bank 3B) 3.3-V LVTTL
MAX10_CLK1_50 | PIN_P11 50 MHz clock input(Bank 3B) 3.3-V LVTTL
MAX10_CLK2_50 | PIN_N14 50 MHz clock input(Bank 3B) 3.3-VLVTTL
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2.3 Using the Push-buttons, Switches and LEDs

B User-Defined Push-buttons

The board includes two user defined push-buttons that allow users to interact with the MAX 10
FPGA device. Each of these switches is debounced using a Schmitt Trigger circuit as indicated in
Figure 2-14. A Schmitt trigger feature introduces hysteresis to the input signal for improved noise
immunity, especially for signal with slow edge rate and act as switch debounce in Figure 2-15 for
the push-buttons connected. Table 2-4 list the pin assignment of user push-buttons.

VCC3P3

KEYO0

e (inteD

I
KEY1 SN74LVC2G17
N &
O— > me @€MAX 10
FPGA
L L T

Figure 2-14 Connections between the push-button and MAX 10 FPGA

lPushbutton depressed lPushbutton released
Before

Debouncing ||||||||| |||||||
Schmitt Trigger

Debounced

v

&
<

Figure 2-15 Switch debouncing

Table 2-4 Pin Assignment of Push-buttons

Signal Name  FPGA Pin No. /O Standard |

KEYIO0] PIN_AB9 Push-button[0] 3.3 VSCHMITT TRIGGER"
KEY[1] PIN_AA9 Push-button[1] 3.3 VSCHMITT TRIGGER"

B User-Defined Dip Switch

There are 4 position dip switches connected to FPGA on the board (See Figure 2-16). These
switches are used as level-sensitive data inputs to a circuit. Every one of the switches is connected
directly and individually to a pin on the MAX 10 FPGA. When the switch is in the ON position

www.terasic.com
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(closest to the edge of the board), it provides a low logic level to the FPGA, and when the switch is
in another position, it provides a high logic level. Table 2-5 list the pin assignments of the user

(intel)

«max 10

AB16 Y16 Vié  AB17

Logic’0”

Figure 2-16 Connections between the slide switches and MAX 10 FPGA
Table 2-5 Pin Assignment of Slide Switches

Signal Name FPGA Pin No. | Description I/0 Standard

SWIO0] PIN_AB16 Dip Switch[0] 3.3-V LVTTL
SWI1] PIN_Y16 Dip Switch[1] 3.3-V LVTTL
SWI2] PIN_V16 Dip Switch[2] 3.3-V LVTTL
SWI3] PIN_AB17 Dip Switch[3] 3.3-V LVTTL

B User-Defined LEDs

There are also four user-controllable LEDs connected to FPGA on the board. Each LED is driven
directly and individually by a pin on the MAX 10 FPGA; driving its associated pin to a high logic
level turns the LED on, and driving the pin low turns it off. Figure 2-17 is the connections between
LEDs and MAX 10 FPGA. Table 2-6 list the pin assignment of user LEDs.

www.terasic.com
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AA16 _LEDGO . A _LEDGO Flm
- t l@
ln e : AB15 LEDG1 A A _LEDG1 blm
" A _LEDG2 LEDG2
<max 10 AEDGZ ANAERE2 T
FPGA
AA14) _LEDG3 , A LEDG3 ”22

Figure 2-17 Connections between the LEDs and MAX 10 FPGA

Table 2-6 Pin Assignment of LEDs

Signal Name FPGA Pin No. | Description I/0 Standard

LED[O] PIN_AA16 LED [0] 3.3-V LVTTL
LED[1] PIN_AB15 LED [1] 3.3-V LVTTL
LED[2] PIN_AA15 LED [2] 3.3-V LVTTL
LED[3] PIN_AA14 LED [3] 3.3-V LVTTL

2.4 Using WS2812B RGB LED

The board has Built-in the four Color LED (WS2812B) with intelligent controller (See Figure 2-18)
and the four LED are connected in series controlled by one GPIO line. The WS2812B is an
intelligent control LED light source that the control circuit and RGB chip are integrated in a
package of 5050 components. It internal includes intelligent digital port data latch and signal
reshaping amplification drive circuit. Also includes a precision internal oscillator and a 12V voltage
programmable constant current control part, effectively ensuring the pixel point light color height

consistent.
WS2812B WS2812B WS2812B WsS2812B 5V up3
. l§|DO DL@ = DL|§| = DLD = L.
_> > > > :
L
U114

Level Shift

«max 10
5V
OB_LED_RGB D OB_LED_RGB_DIN JP4
D1.9 ;’ = — — L
. EX_LED RGB D EX_LED RGB_DIN
- EIETTY “Leo s, ;.
—

Figure 2-18 Level Shift between the REG LEDs and MAX 10 FPGA
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B Control Method

For the WS281B RGB LED, each R/G/B color can be independently controlled, and each color can
be adjusted from level O to 255. Therefore, each color needs to use 8bit control, and each LED
needs 24bit control. The 24 bits corresponds to the Figure 2-19.

Composition of 24bit data:

G7|G6|G5|G4(G3|G2|G1|G0|R7|R6|R5|R4|R3|R2|R1|R0|B7|B6|B5|B4|B3|B2|B1|B0

Note: Follow the order of GRB to sent data and the high bit sent at first.
Figure 2-19 Composition of 24bit data

The logic 1 or 0 of each bit is determined as shown in Figure 2-20. It is determined by the length of
the voltage level in a period. Detailed specifications can refer to Table 2-7.

TOL
TOH
1 code |« > T]Lb
TIH
RET code m——ooct

Figure 2-20 Sequence Chart
Table 2-7 Code Timing

TOH 0 code, high voltage time 220ns~380ns
T1H 1 code, high voltage time 580ns~1us
TOL 0 code, low voltage time 580ns~1us
T1L 1 code, low voltage time 220ns~420ns
RES Frame unit, low voltage time >280us

The data transfer protocol of the WS281 use single NRZ communication mode. As shown in Figure
2-21, after the pixel power-on reset, the DI port receive data from controller, the first pixel collect
initial 24bit data then sent to the internal data latch, the other data which reshaping by the internal
signal reshaping amplification circuit sent to the next cascade pixel through the DO port. After
transmission for each pixel, the signal to reduce 24bit. Pixel adopt auto reshaping transmit
technology, making the pixel cascade number is not limited the signal transmission, only depends
on the speed of signal transmission.

IC T-Core 19 www.terasic.com
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Cascade method:

Figure 2-21 Data Transmission Method

D1 D2 D3 | D4
—{ DIN DO DIN DO DIN DO
PIX1 PIX1 P1X1
Data transmission method:
—| reset code |« reset
>=50us code
< Data refresh cycle 1 Data refresh cycle 2
first [second| third first |second| third
D1 24bit | 24bit | 24bit 24bit | 24bit | 24bit
second| third second| third
24bit | 24bit 24bit | 24bit
D2
third third
D3 24bit 24bit
D4

The DIN signal level of the WS2812B is 5V, so a Level Shift will be required to raise the control
signal voltage to the 5V level. Table 2-8 shows the pin assignment of RGB LED Control signal.

More information about the RGB Color LED is available in its datasheet. It can be found on

manufacturer’s website or in the directory \Datasheet\RGB_LED of system CD.

Table 2-8 Pin Assignment for RGB Color LED and Extension port

FPGA Pin No. /0 Standard

Signal Name

OB_LED_RGB_D

PIN_D19

On-Board RGB LED Data IN

3.3-V LVTTL

EX_LED_RGB_D

PIN_D18

RGB LED Data IN for External Header

3.3-V LVTTL

B Expansion Port

In addition to the Built-in four RGB LEDs on the T-Core board, two 3-pin headers (JP3 and JP4)
are reserved for user to expand more LED. Users can purchase the commercially RGB LED Line
Pipe in series to make the application more widely available.

See Figure 2-22, if user expands more RGB LEDs on JP3, it must be noted that the control method
should take into account that there are four on board LEDs on the front end. If you use JP4 to
expand and connect more LEDs, you only need to consider the newly added LEDs for the

controlling.

For these 3 pins header, detailed information is described as follows:
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Pin 1 of the 3-pin header is a 5V power supply, but may not provide sufficient current for the
extended LED strip (when connected a lot). Therefore, if the user needs to connect more than one
LED strip, please do not connect the pin.1 of the 3-pin header, please supply it to the LED strip by
an external 5V power supply.

Pin 2 of the header is a serial control signal with a voltage level of 5V. The user can define an
arbitrary waveform to output.

Pin 3 is grounded. Please note that if the external light strip is attached, the ground of the light strip
should be connected to this pin.

For detailed RGB LED and JP3/JP4 position, please refer to Figure 2-22, simple connection
method, refer to Figure 2-23.

- pin.1  VCC5
[ pin2 OB_LED_RGB_DOUT

/ pin.3 GND
———pin.1 VCC5

/ pin.2 EX LED_RGB_DIN

P3 / /3P4 pin.3 GND

EEEEEEEE &= ot — RGB_LEDO

RGB_LED3

*us W

GND/SV

Power Supply 5V

Figure 2-23 An example of a color light bar connection for an external power supply

2.5 Using 2x6 TMD GPIO Expansion Headers

The board has one 2x6 TMD (Terasic Mini Digital) expansion header. The TMD header has 8
digital GPIO user pins connected to the MAX 10 FPGA, two 3.3V power pins and two ground pins.
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There are two Transient Voltage Suppressor diode arrays used to implement ESD protection for 8
GPIO user pins.

Figure 2-24 shows the connection between the TMD header and MAX 10 FPGA. Table 2-9 shows
the pin assignment of 2x6 TMD header.

VCC3P3

%

intel)

<max 10

TMD_D[7..0]

Figure 2-24 Connections between the 2x6 TMD header and MAX 10 FPGA
Table 2-9 Pin Assignment of 2x6 TMD Header.

Signal Name __FPGA Pin No. /0 Standard

TMD_DI[0] PIN_ABS8 GPIO Connection [0] 3.3-V LVTTL
TMD_D[1] PIN_AAS8 GPIO Connection [1] 3.3-V LVTTL
TMD_D[2] PIN_AAS5 GPIO Connection [2] 3.3-V LVTTL
TMD_D[3] PIN_ABS GPIO Connection [3] 3.3-V LVTTL
TMD_D[4] PIN_AB7 GPIO Connection [4] 3.3-V LVTTL
TMD_D[5] PIN_AA7 GPIO Connection [5] 3.3-V LVTTL
TMD_D[6] PIN_ABG6 GPIO Connection [6] 3.3-V LVTTL
TMD_D[7] PIN_AA6 GPIO Connection [7] 3.3-V LVTTL

2.6 1x10 A/D Converter and Analog Input

The board has eight analog inputs are connected to MAX 10 FPGA ADCI, through a 1x10 header
(JP1) input. Any analog inputs signals sourced through the header JP1 are RC filtered by the Analog
Front-End circuit, and the maximum allowable input voltage 2.5V per the MAX 10 FPGA ADC IP
block. Figure 2-25 shows the connections between the header input and FPGA.
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ADC1IN[8..1]

ADC_IN[7..0]

JP1
ADC_INO pin.1
ADC_IN1
ADC_IN2
ADC_IN3
ADC_IN4
ADC_IN5
ADC_IN6
ADC_IN7
GND

Figure 2-25 Connections between the Arduino Analog input and MAX 10 FPGA

Table 2-10 shows the pin assignment of 1x10 Analog input header.

Table 2-10 Pin Assignment of Analog Input

ADC IN [0] PIN_ PIN.F5 Analog Input Data[0] 2.5-VLVTTL
ADC_IN [1] PIN_F4 Analog Input Data[1] 2.5-VLVTTL
ADC_IN [2] PIN_]J8 Analog Input Data[2] 2.5-VLVTTL
ADC_IN [3] PIN_J9 Analog Input Data[3] 2.5-VLVTTL
ADC_IN [4] PIN_J4 Analog Input Data[4] 2.5-VLVTTL
ADC_IN [5] PIN_H3 Analog Input Data[5] 2.5-VLVTTL
ADC_IN [6] PIN_Kb5 Analog Input Data[6] 2.5-VLVTTL
ADC_IN [7] PIN_K6 Analog Input Data[7] 2.5-VLVTTL

2.7 Using QSPI Flash

The board supports a 64M-bit serial NOR flash device for non-volatile storage, user data and
program. This device has a 4-bit data interface and uses 3.3V CMOS signaling standard.
Connections between MAX 10 FPGA and Flash are shown in Figure 2-26. Table 2-11 shows the
QSPI Flash pin assignments
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<« QSPLFLASH DATA] [ 1 s
: ’_ <« OSPLFLASH DATAR] f \our o
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< QSPLFLASH DATAID] | /no0
<max 10 QSPL FLASH SCLK o f oy ¢
QSPI FLASH CEN | pu
FLASH

Figure 2-26 Connections between MAX 10 FPGA and QSPI Flash

Table 2-11 Pin Assignment of QSPI Flash

Signal Name | FPGA Pin No. /O Standard

QSPI_FLASH_DATA[0] | PIN_P21 FLASH Data[0] 3.3-VLVTTL
QSPI_FLASH_DATA[1] | PIN_P18 FLASH Data[1] 3.3-VLVTTL
QSPI_FLASH_DATA[2] | PIN_R18 FLASH Data[2] 3.3-VLVTTL
QSPI_FLASH_DATA[3] | PIN_P20 FLASH Data[3] 3.3-VLVTTL
QSPI_FLASH_SCLK PIN_P19 FLASH Data Clock 3.3-VLVTTL
QSPI_FLASH_CEN PIN_L22 FLASH Chip Enable 3.3-VLVTTL
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Chapter 3

Example Designs

This chapter provides examples of advanced designs implemented by RTL or Qsys on the T-Core
board. These reference designs cover the features of peripherals connected to the FPGA, such as
RGB LED. All the associated files can be found in the directory \Demonstrations of T-Core System
CD.

B Installation of Demonstrations
To install the demonstrations on your computer:

Copy the folder Demonstrations to a local directory of your choice. It is important to make sure the
path to your local directory contains NO space. Otherwise, it will lead to error in Nios II software.

Note: Quartus Prime Standard v18.1 or later is required for all T-Core demonstrations to support
MAX 10 FPGA device.

3.1 T-Core Factory Configuration

The T-Core board has a default configuration bit-stream pre-programmed, which demonstrates some
of the basic features onboard. The setup required for this demonstration and the location of its files
are shown as below.

B System Block Diagram

Figure 3-1 shows the system block diagram of this demonstration. This system can control the four
on-board green LEDs to all light on or blink. It can also control the four on-board RGB LEDs to
display the Red/Green/Blue/White colors, or the 0~360degree continuous color according to the
Hue of the HSL Color Model.
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MAX 10

@ﬂ, PLL100

50Mhz
W ram_data[23:0]
A COLOR ram_wraddress[n-1 :0] [PIONIEN FX | ED RGB DIN &
Color_selection = latetedd EX_LED_RGB_|
= Processer OB_LED_RGB_DIN
- COLOR([23:0] update_reqeust : SZmCS -
_’ »
I

LED_flicker
—b

50Mhz
v

ram_wrclock

update_done
—>

Figure 3-1 Block diagram of the Default demo
Below is the description for the block diagram:
1. PLL100: PLL module. Input S0OMHz clock and output 100MHz clock.
2. KEY1: It is used to reset the system.

3. Color_selection: Provides four fixed colors Red/Green/Blue/White or the 0~360 degree
continuous color according to the Hue of the HSL Color Model. When the KEYO is pressed, the
color of the four on-board RGB LEDs is depending on the SW[1:0] setting, they will display
Red/Green/Blue/White color respectively when the SW[1:0] is set as 00/01/10/11. If the KEYO
is not pressed, the four RGB LEDs will display 0~360 degree continuous color.

4. LED_flicker: It controls the four on-board green LEDs to all light on or blink with 1Hz
frequency. The four LEDs will all light on when KEYO is pressed, or will blink with 1Hz if the
KEYO is not pressed.

5. WS2812: It is the WS2812 IC control IP, it can control any WS2812 IC, it contains two main
parts:

TWO_PORT_RAM: User can write in the R[7:0] G[7:0] B[7:0] data to control any one of RGB
LEDs to be light as any colors. For example, user can set ram_wraddress=2, ram_data = {R[7:0],
G[7:0], B[7:0]} = {8’h00,8’hff ,8’h00} to make the RGB LED3 light as Green, then set the
ram_wrclock to 0->1->0, the data will be written to the RAM.

ILED_CONTROLLER: After the LED RGB data is written successfully, active the
update request as “1” to inform the ILED CONTROLLER read out the RGB data in sequence
through the TWO_PORT_RAM, and input to the corresponding LED. The update_request must
return to “0” after a short of delay (>0.02MHz). The DOUT is the bit string data, the “0”/“1”
Sequence chart of each bit is generated according to WS2812 datasheet page 4. The sequence chart
of each RGB bit is generated according to WS2812 datasheet page 5. After all the data is transferred
to WS2812 RGB LED, this module will return update done ="1” to indicates the data transmission
is completed.
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6. COLOR_Processer: It will extract the color date from Coloe_selection according to WS2812
IP controlling request, then output to the TWO_PORT_RAM in WS2812 IP, when this is
completed, it will inform the ILED_CONTROLLER in WS2812 IP to sequence read out the
RGB data stored in TWO_PORT _RAM, then the ILED CONTROLLER will transfer the RGB
data to each WS2812 IC and wait for update _done = “1” returned by ILED CONTROLLER, it
indicates the process is completed.

B Demonstration File Locations

e Project directory: \Default
e Bitstream used: T_CORE_Default.sof, T_CORE_Default.pof
B Demonstration Setup and Instructions
¢ Connect the Mini USB connector (J2) of the T-Core board to the host PC with a USB cable and
install the USB-Blaster II driver if necessary.
e Execute the demo batch file “test.bat” from the directory \Default\demo_batch\

oIf the KEYO is not pressed, the four on-board green LEDs will blink in 1Hz and the four
on-board RGB LEDs will display 0~360 degree continuous color according to the Hue of the
HSL Color Model.

o If the KEYO is pressed on (do not release), the four on-board green LEDs will all light on, the
color of the on-board four RGB LEDs is depending on SWJ[1:0], they will display
Red/Green/Blue/White color respectively when the SW[1:0] is set as 00/01/10/11.

e Figure 3-2 shows the color of the four on-board green LEDs and RGB LEDs display.
RGB LED

rl!xll’;

> | B
oo ®® !@

Green LED

Figure 3-2 On-Board Green LED and RGB LED display
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B Restore Factory Configuration
e Connect the mini USB connector (J2) of the T-Core board to the host PC with a USB cable and
install the USB-Blaster II driver if necessary.
e Execute the demo batch file “program.bat” from the directory \Default\demo_batch\

e After the program is executed successfully, the program message as shown in Figure 3-3.
Please press any key to continue and the window will be closed.

B CAWINDOWS\system32\cmd.exe

Figure 3-3 Quartus Prime Program MAX 10 CFM message

3.2 Control RGB LED in Nios 1l

Based on this demonstration, user can quickly learn how to develop C language program to control
the RGB LED:s, it provides corresponding API function and allows the user to quickly started.

B System Block Diagram

Figure 3-4 shows the system block diagram of this demonstration. Nios II CPU and WS2812
Controller must run in 100MHz, the on-board OSC 50MHz needs to be multiplied to 100MHz
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through the PLL, the JTAG is used to print information, the Nios II required a system time, the C
language program is stored in On-Chip memory, user can develop C program to call the API
WS2812 Controller, then control the RGB LEDs. User can also control the external RGB LED by
modifying the parameters in the C program.

FPGA
©)—  asys

50 MHz
Nios Il & — 2

JTAG B 3
-

Figure 3-4 Block diagram of the SDRAM test in Nios 11

" On-Chip
Memory

1

EX_LED _RGB_D
*

WS2812 ¥ OB_LED_RGB_D

Controller

PLL

1

System Intercoment Fabric

B Design Tools

e Quartus Prime v18.1
e Nios II Eclipse v18.1

B Demonstration Source Code

¢ Quartus project directory: \RGBLED_NIOS
e Nios II Eclipse directory: \RGBLED_NIOS\Software

B Nios II Project Compilation

o Click “Clean” from the “Project” menu of Nios II Eclipse before compiling the reference
design in the Nios II Eclipse.

B Demonstration Batch File

o The files are located in the director: \RGBLED NIOS\demo_batch

¢ The folder includes the following files:
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e Batch file for USB-Blaster II: test.bat and test.sh
¢ FPGA configuration file: T_CORE.sof
e Nios II program: WS2812_Test.elf

B Demonstration Setup

e Quartus Prime v18.1 and Nios II v18.1 must be pre-installed on the host PC.

e Connect the T-Core board to the host PC with a USB cable and install the USB-Blaster driver if
necessary.

¢ Execute the demo batch file “test.bat” from the directory \REGLED_NIOS\demo_batch

o After the program is downloaded and executed successfully, a prompt message will be
displayed in nios2-terminal.

eThe program will display the test progress and result, as shown in

B Altera Nios I| EDS 18.1 [gecd]

Figure 3-5.

eAs shown in Figure 3-6, the RGB LED[3:0] display purple/green/orange/red and
red/orange/green/purple respectively in turns.
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o—

B8 Altera Nios Il EDS 18.1 [geed]

Figure 3-5 Display the progress and the result for the WS2812 test in Nios 11

= s Ve

!

768 LED [3.0)
CQNF_D

Figure 3-6 The RGB LEDs display after executing the batch file
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3.3 Control External RGB LED in Nios 1l

This demonstration is very similar to the one in section 3.2. The difference is that user need to
connect external RGB LEDs. Without the external power, the T-Core can control almost 10~20
external RGB LEDs, the quantities of external RGB LEDs are depending on the user’s code which
is used to control the LED lightness.

User can refer to below demonstration to modify the C program and control the external RGB
LEDs.

#define LED_NUM 143 // modify LED number

//call function WS2812_LED_SET(alt_u32 SelLED,alt_u8 R_Color, alt_u8 G_Color, alt_u8 B_Color)

//SelLED: Select LED ,Red: 8Bit ,Green: 8Bit ,Blue: 8Bit

WS2812_LED_SET(100,30,0,0); // set number 100 LED to red color.

WS2812_update();//update status

B Design Tools

e Quartus Prime v18.1

e Nios II Eclipse v18.1

B Demonstration Source Code

¢ Quartus project directory: \RGBLED_ NIOS_EXT
e Nios II Eclipse directory: \ RGBLED_ NIOS_EXT\software

B Demonstration Batch File

o The files are located in the director: \ RGBLED NIOS_EXT\demo_batch
e The folder includes the following files:

e Batch file for USB-Blaster: test.bat and test.sh

¢ FPGA configuration file: T_CORE.sof
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e Nios II program: WS2812_Test.elf

B Demonstration Setup

e Quartus Prime v18.1 and Nios II v18.1 must be pre-installed on the host PC.

¢ As shown in Figure 3-7, connect the external RGB LED strip to the JP3 or JP4 port of T-Core
board, the pin marked with red box is connected to VCC, the pin marked with green box is
connected to the signal, the pin marked with yellow box is connected to GND.

e Connect the T-Core board to the host PC with a USB cable and install the USB-Blaster driver if
necessary.

e Execute the demo batch file “test.bat” from the directory \RGBLED_ NIOS_EXT\demo_batch

e After the program is downloaded and executed successfully, a prompt message will be
displayed in nios2-terminal.

e The color of external RGB LED strip will change in turn.

'Tﬁ'*u
 EEEEEEEH! HL o

crn Il'l’\ ra.nnt :).A.

Figure 3-7 External RGB LED connection diagram

3.4 ADC Measurement

This demonstration shows how to use the FPGA on-die ADC to measure the input power voltage
from the eight analog input pins among the ADC connector. The measured voltage is displayed on
the Signal Tap. Figure 3-8 shows the block diagram of this demonstration. The main control uses
the Intel ADC IP to retrieve the 12-bit digitalized analog value according the channel specified by
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the SWITCH on the T-Core board. The input voltage can be calculated based on the 12-bit digital
value. Finally, the voltage value will be displayed on the Signal Tap Logic Analyzer.

The 12-bit represents 0~2.5V input voltage to the ADC hardware. The input voltage to the ADC
analog input can be calculated with the formula listed below:
Voltage input= (12-bit integer value)/4096 x 2.5

FPGA

ndu| Bojeuy
alempieH Oay

>
&)
O
I
m
>
&)
m
Py

N >

Figure 3-8 Block diagram of the ADC measurement demonstration

Table 3-1 The SW[2:0] Setting

SW(2:0) ADC_Source

3°b000 ADC_INO
3°b001 ADC_IN1
3’6010 ADC_IN2
3°b011 ADC_IN3
3°b100 ADC IN4
3°b101 ADC_IN5
3'b110 ADC_ING6
3°b111 ADC_IN7

In the demonstration, a Signal Tap is provided to display the retrieved 12-bit digitalized value and
the calculated voltage for the input power to the analog input as shown in Figure 3-9.

#cur_adc_ch[4..0] : 01h
response_valid | | "_
#-adc_sample data[11.0] " 3031 | 3033 |
#- ol mV[11..0] 2300 | 2400 |
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Figure 3-9 Signal Tap of ADC
B Design Tools
e Quartus Prime 18.1 Standard Edition
B Demonstration Source Code

¢ Quartus Project directory: ADC_RTL
e Bitstream used: T_CORE.sof
e Demo Batch File: ADC_RTL\demo_batch\test.bat

B Demonstration Setup

e Make sure Quartus Prime is installed on your PC

¢ Connect analog source to the analog input as shown in Figure 3-10.

Variable Voltage 0~2.5V
- il Variable Voltage Circuit

Analog Input

[ 1 _Jsli
EEREEEOunTTI

P

3.3V DC GND
Power

Figure 3-10 Connect analog source to the analog input

e Use the USB Cable to connect your PC and the FPGA board and install USB Blaster II driver if
necessary.

e Execute the demo batch file “test.bat” from the directory ADC_RTL\demo_batch.

e Use SW[2:0] to specify measured analog input channel.
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e The measured channel and voltage will be displayed on Signal Tap Logic Analyzer as shown in
Figure 3-11.

In the above steps we use a self-made variable voltage output circuit. It uses the T-Core 3.3V as the
power source, the output voltage is adjusted by the divider resistance and the variable resistor of the
circuit, which can convert the T-Core 3.3V to a 0~2.5V analog input (to the ADC_INO channel).

Note: Users can input their own power source, please make sure the input voltage is 0~2.5V,
otherwise there is a risk of damage to the development board.

= Quartus Prime Signal Tap Loge Analyzer Standard Edtion - [ade ntpl* e -
e Lon Yew Prcesang Jools  pelp ®
- W . Qo "
ratance Masager A ) B 5D feady 10 scquire X | STAG Chain Configurationy JTAG ready x
- s " LEs A3 vory 61440  Sevalt -
atace Suta Eradied LEs » Memocy 61440 Senall NA Medum NA Lirge NA Yardware: | TCone (US8-1) =
%] suto_vgralnap 0 Nt munrung J 539 cells 61440 bits A ra NA

Device @) 1OMSOOAM [ESY M50 © Scan Chan

»» | SOF Marager k' | B 2 Ses/OE_CORE sof

16 Trg § 201906124 170440 RO02 elapied) 02
I!’.L,ﬁ‘.‘f_‘] Name | B 2 £ B 138 180 192

* * our ade N4 0]
°

response_vabd 1 | | A l | 1

) * adc_sample_dataf11.0] 2oy Laeaz | aeac 1 e
$ * wol_mv{11.0 FETTENN FT TN ETITE TS

Figure 3-11 Signal Tap Logic Analyzer displays the measured channel and voltage

3.5 RISC-V

B RISC-V Brief Introduction

RISC-V is a free and open Instruction Set Architecture (ISA) enabling a new era of processor
innovation through open standard collaboration. Any organization or individual can design their
own processor based on the RISC-V architecture. Freedom E300, a RISC-V core implemented in
RTL, is realized on T-Core FPGA Board. For more information about Freedom E300, user can learn
more from web (https://github.com/sifive/freedom).

Figure 3-12 shows the top-level block diagram of the Freedom E300 which contains an E31
Coreplex, a selection of flexible I/O peripherals, a dedicated off-chip Quad-SPI flash controller with
execute-in-place support, On-chip Memory, clock generation, and an always-on (AON) block. In
addition, custom accelerator can be added to provide application-specific processing.
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L5 Reset Unit

Freedom E300 Platform

Figure 3-12 Top-Level Block Diagram of the E300 platform

The memory map of Freedom E300 is shown in Table 3-2.

\ Base
0x0000_0000
0x1000_0000
0x1000_8000

0x1001_0000
0x1001_1000
0x1001_2000
0x1001_3000
0x1001_4000
0x1001_5000
0x1002_3000
0x1002_4000
0x1002_5000
0x1003_4000
0x1003_5000
0x2000_0000
0x4000_0000

0x8000_0000
0x8002_0000

Rasic]
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Table 3-2 Memory map of Freedom E300

Top Description

OxOFFF_FFF refer E3 Coreplex Manual

0x1000_7FFF Always-On (AON)

0x1000_FFFF Power, Reset, Clock,
(PRCI)

0x1001_OFFF On-chip OTP control

0x1001_1FFF On-chip eFlash control

0x1001_2FFF GPIOO

0x1001_3FFF UARTO

0x1001_4FFF QSPIO

0x1001_5FFF PWMO

0x1002_3FFF UART1

0x1002_4FFF QSPI1

0x1002_5FFF PWMI1

0x1003_4FFF QSPI2

0x1003_5FFF PWM?2

0x3FFF_FFFF QSPIO XIP

0x7FFF_FFFF Additional I/O or RAM

0x8001 FFFF Instruction and Data RAM
O0xFFFF_FFFF Additional RAM
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B About Quartus Project

The original Freedom E300 was implemented in the Scala and is not suitable for the T-Core FPGA
board. We modified the Scala source code so that it can run on T-Core. Since the Verilog code
generated by the Scala is hardly readable, we encapsulate it. Place the clock, reset, JTAG interface,
QSPI interface, GPIO interface (including various peripherals such as UART, I2C, SPI, etc.) on the
top-level port for easy logic operation and pin connection to the FPGA. The interface of the top file

is as follows.

149 @EFreedom_E300 wrapper E300_soC_wrapped(

150 '*1nput

151 *input

152

153 /*input

154 /¥input

155 /*output
156

157 /*input

158 /*input

159 /¥input

160 /¥output
161

162 /¥output
163 /¥output
164 /*inout

165

166 /¥input

167 /¥output
168 f“output
169 *output
170

171 )

Add the PLL, Clock, LED and control logic to the Freedom_E300_Wrapper to generate the
complete Quartus Project. The block diagram is shown below. The completed Quartus project is
detailed in the demonstration directory.

Rasic]
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[3:0]

[31:0] */

[31:0] *

[31:0] */
[31:0] */

.clock

.aon_lfextclk

.aon_erst_n
.jtag_reset
.lo_ndreset

.jtag_tck
.jtag_tms
. jtag_tdi
.Jjtag_tdo

.gspi_sck
.gspi_cs_0
.gspi_dq

.e300_gpio_i_ival
.e300_gpio_o_ie
.e300_gpio_o_oval
.e300_gpio_o_oe

38

(c1k_32m),
(sTowclk),

(~ip_reset_sys_peripheral_reset),
(fpga_power on_| Bower _on_reset),

(ip_reset_sys_m

(RISCV_JTAG_TCK),
(RISCV_JTAG_TMS),
(RISCV_JTAG_TDI),
(RISCV_JTAG_TDO),

(QSPI_FLASH_SCLK),
(QSPI_FLASH_CE_n),
(QSPI_FLASH_DATA),

_debug_sys_rst),

(e300_gpio_i_ival),

(e300_gpio_o_ie),

(e300_gpio_o_oval),

(e300_gpio_o_oe)
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T-Core

FPGA

E300 Platform
(Freedom_E300_Wrapper)

eFlash
EEPROM
Quad SPI Flash

GPIO Complex

e :
Coerplex
UART
QSPI

P-Bus: TileLink B32 D32

Clock Generation PLL ——m

Always-On Block

Power Management
Backup Registers
Custom Always-On
Real-Time Clock
Watchdog Timer
Reset Unit

Figure 3-13 Quartus Project System Block
B How to Run Demo (Using Ubuntu)

€ Host PC

A Linux system is required to compile the RISC-V C-code project and download the binary file to
the T-Core QSPI Flash. In the following demo, Ubuntu 16.04 is used and recommended. Quartus
Prime (or Quartus Programmer), USB Blaster II Driver, RISC-V BSP should be installed on the
host PC before running the demo.

4 Intel Quartus Prime

Intel Quartus Prime 18.1 Standard Edition can be download from web site:
http://fpgasoftware.intel.com/18.1/?edition=standard&platform=Ilinux&download_manager=dIm3.

For Quartus Prime installation, please make sure the MAX 10 device is included.
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http://fpgasoftware.intel.com/18.1/?edition=standard&platform=linux&download_manager=dlm3

Quartus Prime Standard Edition

Helease da
Latest Rele

september, 2006

Intel’ Quartus Prime
V18,7

Design Software

! wincows ® Y 1inux

Download Method @ ®akamal DLMI Download Manager @ CDirect Download

o' The Quartis Prime Nesign Software Standard Fdition w18.7 Upidate 1 has been updated with Cur 7.64.0, CypWin
30,3, expat 2,26, flexnet_publisher 11.16.2.7, gbb 2.56.7, gstroamer 1,740, guava 27.0.7, jre (Dracle Java) 1:8.0u202,
Tibicu 61,0, libpng 1.6.36, openss! 1.0:2r, perd .1, pythan 3,68, qt 20 1.3, ool_sqlited 3.26.0, sqlites {python) 3.26.0,
solited (gt} 3,272 kerces-c++ 3.2.2 and 7lib 1.2.11, which include functional and security updates. Users should update
to the latest version of Quartus Mrime desipn software 25 soon as possible.

&' The Quartus Prime Standand soffware version 18.1 suppaorts the following device families: Stratix IV, Stratic W, Arria Il
Arria ¥, Arnia V GZ, Arnia 10, Cyclone 10LP, Cyclone IV, Cyclone V, MAX I, MAX V, and MAX 10 FPGA. - More

!
it s [

Download and install instructions:  ~ Moo
Bead Intel FPGA Software v18,1 Installation FAQ
Quick Start Guide

W select All @

M Quartus Prime Standard Edition

Uipdates Available

|«|Quartus Prime {includes Nios Il EDS)
1zer sl GH LAV SCIETIRE M NAOFOALEE
_|ModelSim-intel FPGA Edition (includes Starter Edition)
Size: 1 D5: 4678A15¢ 74 FCRND993
**Req s, soe - installation manual
M Devices

You must install device suppart for at least one device family to use the Quartus Prime softwan

| &rria Il device support
Size: GEA.T MB MD5: 3F397RIGCCHES

RO7RFSACEH?
| Arria 10 device support @

Arria 10 device support Part 1
Size: 1.2 GB MD5: EAY

Arria 10 device support Part 2

Slze: 2.5 GH MD5: ESHIBE
Arrla 10 device support Part 3
Size: 4.3 GB MDS5: | |

_|Arria V device support
Size: 1.1 GE MD5:

_|Arria V GZ device support
Size: MDS; BAAC

_|Cyclone IV device support
6.6 MA MDS: 4

Size:

|Cyclone 10 LP device support
MB MD5: 72AAFGT

Size:
“|Cyclone V device support
Size: 1.1 GB MD5: 75T

CIMAX NI, MAX V device support
Size: 11.4 M MD5: V775

IMAX 10 FPGA device support
1 MR MD5: F T

Size:

|Stratix [V device support
Size: 544.5 MR MD5: £ 5

_|Stratix V device suj
Size: 2.9 GB MD5:

Download Selected Files i, §
roubleshont dawninad

Note: The Quartus Prime software is 4 Tull-leatured FDA product, Depending on your download speed,
downlosd limes may be lengthy.

Figure 3-14 Download Quartus Prime 18.1 Standard Edition
€ USB-Blaster II Driver

The Intel Quartus Prime software accesses USB-Blaster II through USB file system. After installing
the Quartus Prime software, user need to change the port permissions.
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1. Create a file named /etc/udev/rules.d/51-usbblaster.rules.

2. Add the following lines.

SUBSYSTEMS=="usb", = ATTRS{idVendor}=="09fb", = ATTRS{idProduct}=="6010",
MODE="0666"

SUBSYSTEMS=="usb", = ATTRS{idVendor}=="09fb",  ATTRS{idProduct}=="6810",
MODE="0666"

€ T-Core RISC-V BSP

After Quartus Prime and USB-Blaster II driver are installed, please download the T-Core RISC-V
BSP (TCORE-RISCV-FreedomE300.tar.gz) from the web (http://T-Core.terasic.com/cd). Then,
decompress the file using command: tar -zxvf TCORE-RISCV-FreedomE300.tar.gz. So far, you can
see TCORE-RISCV-FreedomE300 file. For more information about T-Core RISC-V BSP, please
refer following table.

Table 3-3 T-Core RISC-V BSP

Quartus_Project/TCORE_FreedomE a Quartus Prime project, contains a RISC-V Core,
300 Freedom E300.
Quartus_Project/ the top file of Freedom E300. User can use it to connect

TCORE_FreedomE300/V/Freedom_  to do logic operation, etc.
E300_Wrapper.v

Toolchains prebuilt tools for compiling and debugging programs.
freedom-e-sdk/bsp/drivers contains some driver code, such as the underlying driver
code for PLIC modules, PRCI, etc.
freedom-e-sdk/bsp/include contains header files for register address and parameter of
modules, such as SPI, UART, GPIO, etc.
freedom-e-sdk/bsp/libwrap contains specific implementation of underlying library

functions related to the hardware platform.
freedom-e-sdk/bsp/env/freedom-e300 contains Terasic T-Core board supported package.
-terasic
freedom-e-sdk/software contains demonstration for reference.
freedom-e-sdk/Makefile the main Makefile for compilation and debug.

4 Download a pof file to FPGA
Follow the procedures below to write RISC-V FPGA configure data into MAX10 internal flash.

o Make sure SW2 is changed to correct location, set SW2.1=0 and SW2.2=1, as shown in
Figure 3-15 to ensure MAX10 is on JTAG chain, and RISC-V is off JTAG chain.
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http://t-core.terasic.com/cd

JTAG CHAIN

fivlae

Figure 3-15 SW2 Setting

o Make sure Quartus Prime 18.1 Standard Edition is installed to the host PC.

o Connect the T-Core board (J2) to the host PC via the USB cable.

o Go to TCORE-RISCV-FreedomE300/Quartus_Project/ TCORE_FreedomE300/demo_batch
directory using command:
cd TCORE-RISCV-FreedomE300/Quartus_Project/ TCORE_FreedomE300/demo_batch.

o Execute command: sh programming_pof.sh to configure the FPGA.

4 Download bitstream to QSPI Flash

Follow the procedures below to compile a C-code project and download the generated binary file
into QSPI Flash via on-board RISC-V JTAG.

o Remove the USB Blaster Cable from T-Core to power off the board.
o Set SW2.1=1 and SW2.2=0 as Figure 3-16 to ensure MAXI0 is off JTAG chain, and
RISC-V is on JTAG chain.

Figure 3-16 SW2 Setting

Connect the T-Core board (J2) to the host PC via the USB cable.

Change the directory to TCORE-RISCV-FreedomE300/freedom-e-sdk using cd command.
Compile software by executing command: make software.

Download the binary file by executing command: make upload.

o O O O
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M5 & terasic@terasic: ~/Desktop/ TCORE-RISCV-FreedomE300/freedom-e-sdk

terasic@terasic:~/Desktop/TCORE-RISCV-FreedomE300/freedom-e-sdk$ make upload
work/build/openocd/prefix/bin/openocd -f bsp/env/freedom-e380-terasic/openocd.cfg & \
Jhome /terasic/Desktop/TCORE-RISCV-FreedomE300/freedom-e-sdk/work/build/riscv-gnu-toolc
hain/riscv64-unknown-elf/prefix/bin/riscv64-unknown-elf-gdb software/demo gpio/demo_gp
io --batch -ex "set remotetimeout 248" -ex "target extended-remote localhost:3333" -ex
"monitor reset halt" -ex "monitor flash protect @ 64 last off" -ex "load" -ex "monito
r resume” -ex "monitor shutdown" -ex "quit"
Open On-Chip Debugger 08.10.0+dev-00624-g09016bc (201%-087-16-15:47)
Licensed under GNU GPL v2
For bug reports, read
http://openocd.org/doc/doxygen/bugs.html
Warn : Adapter driver ‘'usb blaster' did not declare which transports it allows; assumi
ng legacy JITAG-only
Info : only one transport option; autoselect 'jtag'
adapter speed: 4000 kHz
Altera UsB-Blaster II (uninitialized) found
: Loading firmware.
: Waiting for renumerate...
: Waiting for renumerate...
: Altera USB-Blaster II found (Firm. rev. = 1.36)
: This adapter doesn't support configurable speed
: JTAG tap: riscv.cpu tap/device found: 8x20000913 (mfg: ©x489 (S5iFive, Inc.), pa
rt: @x@ﬂ@@ ver: axz)
Info : datacount 1 progbufsize=16
: Disabling abstract command reads from CSRs.
Examined RISC-V core; found 1 harts
hart 8: XLEN=32, misa=0x40001105
Listening on port 3333 for gdb connections
Listening on port 6666 for tcl connections
: Listening on port 4444 for telnet connections
3 accepting 'gdb' connection on tcp/3333
Found flash device 'issi is251p064' (ID 8x0017609d)
E)KIE)E)@E}E)E)E)@ in 72 ()
Info : JTAG tap: riscv.cpu tap/device found: 8x20000913 (mfg: ©x489 (SiFive, Inc.), pa
rt: Ox0e80, ver: 0x2)
JTAG tap: riscv.cpu tap/device found: 0x20000913 (mfg: ©x489 (SiFive, Inc.), part: @xe
000, ver: 0x2)
cleared protection for sectors 64 through 127 on flash bank ©
cleared protection for sectors 64 through 127 on flash bank @
Info : JTAG tap: riscv.cpu tap/device found: 6x20000913 (mfg: 8x489 (SiFive,
rt: ox0eee, ver: 0x2)
Loading section .init, size 8x74 lma 0x20400000
Loading section .text, size 0x3c6 lma 0x20400074
Loading section .rodata, size 0x28 1lma 8x2040043c
Loading section .data, size 0x42c lma 0x20400464
Info : Padding image section © at 0x2040043a with 2 bytes
Info : Disabling abstract command writes to CSRs.
Info : JTAG tap: riscv.cpu tap/device found: 0x20000913 (mfg: 0x489 (SiFive,
rt: ox0eee, ver: Ox2)
Start address 0x20400000, load size 2190
Transfer rate: 1 KB/sec, 547 bytes/write.
shutdown command invoked
shutdown command invoked
A debugging session is active.

Inferior 1 [Remote target] will be detached.
Quit anyway? (y or n) [answered Y; input not from terminal]

Remote connection closed
terasic@terasic:~/Desktop/TCORE-RISCV-FreedomE300/freedom-e-sdks I

Figure 3-17 Compile and download process
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Note: When you programming the QSPI Flash, you may encounter the error like Figure 3-18. If so,
you can execute the command: sudo apt-get install libfdtil-dev, as shown in Figure 3-19, to solve
it.

€& @ terasic@terasic: -,o‘DesktuprCDRE RISCV-Freedumanoffreedum -e-sdk

terasic@terasic:~/D CORE-| Freed eed kS make upload
work/build/openocd/pr fle Lnfopenocd -f bsp/env/ reedom e300-terasic/openocd.cf
g &\

/home fterasic/Desktop/TCORE-RISCV-FreedomE300/freedom-e-sdk/work/build/riscv-gnu
-toolchainfriscv64-unknown-elf/prefix/bin/riscve4-unknown-elf-gdb software/demo_
gpio/demo_gpio --batch -ex "set remotetimeout 248" -ex "target extended-remote 1
ocalhost:3333" -ex "monitor reset halt" -ex "monitor flash protect ©® 64 last off
" -ex "load" -ex "monitor resume" -ex "monitor shutdown" -ex "gquit"
work/build/openocd/prefix/binfopenocd: error while loading shared libraries: lib
ftdil.so.2: cannot open shared object file: Mo such file or directory
localhost:3333: Connection timed out.

"monitor" command not supported by this target.

"monitor" command not supported by this target.

You can't do that when your target is ‘exec’

"monitor" command not supported by this target.

"monitor" command not rupported by thla target.

terasic@terasic:~/D

@& @ terasic@terasic: n-,o'DeskI:ap,c"TCDRE RISCV-FreedumEsoo,’l‘reedum -e-sdk

terasic@terasic:~/De p/TCORE-I Freed free ik$ sudo apt-get 1in
stall libftdil-dev
[sudo] password for terasic:

Reading package lists... Done
Building dependency tree
Reading state information... Done
The following additional packages will be installed:
libftdii-2
The following MNEW packages will be installed:
libftdi1-2 libftdii-dev
® upgraded, 2 newly installed, ® to remove and 286 not upgraded.
Need to get © B/248 kB of archives.
After this operation, 3,852 kB of additional disk space will be used.
Do you want to continue? [Y/n] vy
Selecting previously unselected package libftdil-2:amd64.
(Reading database ... 214984 files and directories currently installed.)
Preparing to unpack .../libftdii1-2 1.2-5build1 amd64.deb ...
Unpacking libftdiil-2:amd64 (1.2-5buildl)
Selecting previously unselected package libftdii-dev.
Preparing to unpack .../libftdiil-dev_1.2-5buildil_amd64.deb
Unpacking libftdii-dev (1.2-5buildi)
Processing triggers for libc-bin (2.23-8ubuntuia)
Processing triggers for doc-base (0.10.7)
Processing 1 added doc-base file...
Processing triggers for man-db (2.7.5-1)
Setting up libftdii-2:amd64 (1.2-5buildi)
Setting up libftdil-dev (1.2-5build1l)
Processing triggers for llbc b1n {¢ 23-Bubuntuie) .
terasic@terasic:~/ Eo CORE F ) [ fr

Figure 3-19 Fix the error encountered when programming QSPI Flash
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o Now, you should now be able to observe the green LEDs are blinking.

o Recycle the power, you can also observe the green LEDs are blinking as the demo program
is loaded from QSPI Flash. After the reset operation, the RISC-V core will execute the
demo program. You can program new software into board with the SDK, but the FPGA
image will not be modified.
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Chapter 4

Programming the Configuration

Flash Memory

This tutorial provides comprehensive information that will help you understand how to configure
T-Core board using internal configuration mode. The MAX 10 device on the T-Core board supports
single and dual image boot. This tutorial explains the details of the internal dual image boot and
external image boot. The following sections provide a quick overview of the design flow.

Please note that if you are using the dual image boot function on the T-Core board, you will
need to solder the JP2 2-pin header (pitch 0.100" (2.54 mm)) by yourself.

Please refer to the Figure 4-1 for the JP2 position.

The settings of JP2 are described in Table 4-1.

EUELEE

I5 G LED {3:0] ‘
: ?IE]’ ;'n-l
- o=

JP2

o
>
)
x

Figure 4-1 JP2 position on the T-Core board

Table 4-1 JP2 Jumper setting instructions

Jumper Setting

Open (default)

Boot from image 0

}JPZ

Close

Boot from image 1
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4.1 Internal Configuration

The internal configuration scheme for all MAX 10 devices except for 10MO02 device consists of the
following mode:

eDual Compressed Images — configuration image is stored as image0 and imagel in the
configuration flash memory (CFM).

e Single Compressed Image.

e Single Compressed Image with Memory Initialization.

e Single Uncompressed Image.

e Single Uncompressed Image with Memory Initialization.

In dual compressed images mode, you can use the BOOT_SEL pin to select the configuration
image.

The High-Level Overview of Internal Configuration for MAX 10 Devices as shown in Figure 4-2.

Configuration Data

JTAG
In-System Programming

MAX 10 Device

Internal
Configuration

Figure 4-2 High-Level Overview of Internal Configuration for MAX 10 Devices

Before internal configuration, we need to program the configuration data into the configuration
flash memory (CFM). The CFM will be part of the programmer object file (.pof) programmed into
the internal flash through the JTAG In-System Programming (ISP).

During internal configuration, MAX 10 devices load the configuration RAM (CRAM) with
configuration data from the CFM. Both of the application configuration images, image 0 and image
1, are stored in the CFM. The MAX 10 device loads either one of the application configuration
image from the CFM. If an error occurs, the device will automatically load the other application
configuration image. Remote System Upgrade Flow for MAX 10 Devices is shown in Figure 4-3.
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Reconfiguration Sample _Reconfiguration
3 BOOT Pin 3

Boot_SEL=0 Boot_SEL=1

l - First Error Occurs
First Error Occurs

Second Error Occurs |

l

Reconfiguration

Figure 4-3 Remote System Upgrade Flow for MAX 10 Devices
The operation of the remote system upgrade feature detecting errors is as follows:

1. After powering-up, the device samples the BOOT_SEL pin to determine which application
configuration image to boot. The BOOT_SEL pin setting can be overwritten by the input
register of the remote system upgrade circuitry for the subsequent reconfiguration.

2. If an error occurs, the remote system upgrade feature reverts by loading the other application
configuration image. The following lists the errors that will cause the remote system upgrade
feature to load another application configuration image:

e Internal CRC error
e User watchdog timer time-out

3. Once the revert configuration completes and the device is in the user mode, you can use the
remote system upgrade circuitry to query the cause of error and which application image failed.

4. If the second error occurs, the device waits for a reconfiguration source. If the auto-reconfig is
enabled, the device will reconfigure without waiting for any reconfiguration source.

5. Reconfiguration is triggered by the following actions:
¢ Driving the nSTATUS low externally
e Asserting internal or external nCONFIG low

e Asserting RU_nCONFIG low (Avalon-MM interface signal)
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4.2 Using Dual Compressed Images

Before using MAX 10 Dual Compressed Images feature, users must set these two image files’
Quartus Prime projects as follows:

¢ Add dual configuration IP.

e Modify Configuration Mode in device setting.

First of all, a Dual Configuration IP should be added in an original project, so that the .pof file
can be programmed into CFM through it. Here we use a demonstration named ""LEDO_Blink"' as
an example to add Intel Dual Configuration IP to the project:

1. Open Quartus project and choose Tools > Platform Designer to open Platform Designer GUI

as shown in Figure 4-4.

(Gd Quartus Prime Standard Edition - C:/T-Core System CD/Dual_boot/LEDO _Blink/LEDO Blink - LEDO_Blink = O X
File Edit View Project Assignments Processing Window Help rct " ‘0
r LEDO_Blink - Run Simulation Tool »
Project Navigator « Hierarchy vame x| @ . Launch Simulation Library Compiler IP Catalog e x
Entity B & Launch Design Space Explorer i Y o X |i®
| P Kl
& MAX 10: 10M50DAF484C7G 2 © Timing Analyzer va Inst.alled |_p A
> LEDO_Blink ® \ -] ol 7 v Project Directory
g System
€ € Chip Planner v Library
< > | ; 0 Design Partition Planner Basic Functions
lstatus asx| ¢ Netlist Viewers > DsP
» - 1l 1C : . Interface Protocols
Module  %Progress & Time ‘ i! -2 Signal Tap Logic Analyzer Moo iteruces sid Contralles
; @= |n-System Memory Content Editor Processors and Peripherals
14 = Logic Analyzer Interface Editor University Program
}E o1 In-System Sources and Probes Editor v — = b far D. 1D 2
‘ < Signal Probe Pins... | .- Add...
: & Programmer
& Py . ~
i Partition Name Netlist Type Q\ JTAG Chain Debugger
i "w Design Partitions s
.‘é 8 <Crewss & Fault Injection ?ebugger
a ® Top Source File System Debugging Tools » v
%ﬂ (E(f’,mme'?dafirof‘fjw‘)f" for & P Catalog available until after compilation Details
. Nios Il Software Build Tools for Eclipse - 3
% = x lQuartus Prime Tcl Console
*: ALl |©] A (4 A Filter>> |& Platform Designer | z &
. [rune TN Messane A Lol Scopts- Ii?
Customize... @
@ ; °
gﬂ Options... §
3! License Setup... o
,i System Processing G Ihstalb Devices.. ]
Opens Platform Designer System Integration Tool 0%  00:00:00

Figure 4-4 Select Qsys menu and click

Please choose Library > Basic Function> Configuration and Programming > Dual
Configuration Intel FPGA IP to open wizard of adding dual boot IP. See Figure 4-5 and
Figure 4-6.
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% Platform Designer - unsaved.qsys® (C\T-Core System CD\Dual boot\LEDO Blink\unsaved.qsys) — O X
File Edit System Generate View Tools Help

[ IP Catalog = e E §§%§ !%’ %én!s = Address Map 23‘ Interconnect Requirements & ]
a x ’Q . % 4| @ System: unsaved
Lilidary o . Use C... Name Description Export Clock Base
5‘%3&&2%&0!15 % Bclk 0 Clock Source
HBridges and Adaptors | clk_in Clock Input clk exporte|
HClocks: PLLs and Resets . 2 clk in reset |[Reset Input reset
E‘Con.fmuratmn and Programming : el Clock Output clk 0
* Altera Config Debug Agent v clk_reset Reset Output
* Altera Config Debug Agent Bridge -
.
iw
iw
w
w
w
w
A i
* ASMI Parallel II Intel FPGA IP
.
. i 1 v
< >
[New... | [EGTRE [#add... | < >
"4l ¥ ¥ Current filter:
2 Nes s!!agee“! e =
M reset Type Path Message
e clk 0
L4 >
0 Errors, 0 Warnings ‘-Generate HDL. . . Finish ‘

Figure 4-5 Select Dual Configuration Intel FPGA IP and click.

& Dual Configuration Intel FPGA IP - dual boot 0 X

%R Dual Configuration Intel FPGA IP -
Megotew altera_dual_boot

|' Block Diagram | |' Parameters ‘
|:|Show signals Clock frequency: 50, 0‘ MHz

dual_boot 0

lock

clk
nreset
avalon

eset

alon

altera_dual_boot

< >
Cancel
Figure 4-6 Open wizard and click Finish.
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3. Click Finish to close the wizard and return to the Platform Designer window. Choose
dual_boot_0 and click right key to select Rename it to dual_boot, and connect the clk and
nreset to clk_0.clk and clk_0.clk_reset as shown in Figure 4-7.

< Platform Designer - unsaved.qsys* (C\T-Core System CD\Dual_boot\LEDO_Blink\unsaved.qsys) — O X
File Edit System Generate View Tools Help
“IP Cataloz = _ of m|| & System Contents 83] Address Map $3| Interconnect Requirements - =
x| k¥ % = W System: unsaved Path: dual_boot. nreset
'a“é‘”‘.""}: ‘ 7 : Use C... Name Description Export Clock  Base En
=Basic Functions 7
i Ari thmetic X B clk_()_ Clock Source
HBridges and Adaptors ==} = clk in Clock Tnput clk exporte
[ Clocks: PLLs and Resets s = = clk_in_reset Reset Input reset
\—JCon'fl)zuratlon and Programmins o — ik Clock Output clk 0
- Altera Config Debug Agen - i clk_reset Reset Output
* Altera Config Debug Agen e 2 dual_boot Dual Configuration...
: clk Clock Input clk_0
. Reset Input [
. | | avalon |Avalon Memory Mapp. .. | ekl |
i
.
.
.
* ASMI Parallel II Intel F
.
plDual Conficuration Intel
.
- v
< >
New... | |Edit... + Add. .. < >
ey ; ‘ ¥ ¥ Current filter:
 Hierarchy #¢| Device Fami #® - o
W_; “ = [}
% uns?lved [unsaved. asvs*] e =
s e
‘ﬂ" ;Tls\et Type Path Message
I F : 0 A i
éuatl boot L] |1 Warning |
: a\{ilon - |unsaved. dual boot |duaI,boot. avalon must be connected to an Avalon—MM master
clk
[ - RS
1+4% Connections < >
0 Errors, 1 Warning Generate HDL... Finish

Figure 4-7 Rename and connect dual boot IP OK

4. Click “Generate HDL..” button and click Generate button when popping a window as shown
in Figure 4-8. Click Save it as dual_boot.qsys and the generation start. If there is no error in the
generation, the window will show successful as shown in Figure 4-9.
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& Save System - Platform Designer - unsaved.qgsys* (C\T-Core System CD\Dual_boot\LEDO_Blink\

iFi\e Edit System Generate View Tools Help

| = EE E‘é‘!‘a’!og‘ % -o=| _ Address Map | Interconnect Requirements 23| 5 imi{=)
L [=] S| M Svstem: unsaved  Path: dual boot.nreset
a4 ]
— & Generatio X
Lihrarv - Base En
HBasic Functions |
FHArithmetic Al
[HBridees and Adap{ [ Synthesi k
E}Clocksr PLLs and Ll
—tConfiguration ang - X . - .
= i Synthesis files are used to compile the system in a Quartus project.
: Hggz Egﬁg: Create HDL design files for synthesis: |Verilog v
.
- : DCrEaf,E timing and resource estimates for third-party EDA swynthesis tools.
- |
. | [create blo i )
S ! i " |Save changes? X G
i ,
- | 5 "o
o ASMI Paralle| | The ;iml'llaticn Save Syst ,E Save changes to unnamed? B e ineide
. | simulation—on -
B¥Dual Conficyl ‘ Save Don’t Save Cancel Close
: | Simulation sel____ - — — - ___cifie
( =t ot sub—directory in the specified output directory.
Follow the guidance in the generated simulation scripts about how to structure your
New... Bdit..n design’ s simulation scripts and how to use the Ip-setup—simuzlation and >
Ip-make—simscript command-line utilities to compile all of the files needed for
T oo simulating all of the IP in your design. >
e = e s ) S =]
unsaved [unsaved. q | ¢ >
o= clk
E5
e Gane
=4 dual boot
%" Eﬂﬁlon a unsaved. dual_boot |dual_boot. avalon must be connected to an Avalon—MM master
=clk
ity
=88 Connections < >
0 Errors, 1 Warning Generate HDL. .. Finish_

Figure 4-8 Generate and Save Qsys.

& Generate Completed X

rrugre I TeT T IIE  CUMIITC TIOn
@ Progress: Validating ~
@ Progress: Done reading input file

“Warning: dual boot. dual boot: dual boot. avalon must be conn
@ Info: dual boot: Generating dual boot “dual boot” for QUARTU
© Info: dual boot: generating top-level entity altera_dual boot

© Info: dual boot: “dual boot” instantiated altera_dual boot

© Info: rst_controller: “dual boot” instantiated altera_reset
@ Info: dual_boot: Done “dual_boot” with 3 modules, 7 files

@ Info: qsys—generate succeeded.

@ Info: Finished: Create HDL design files for synthesis hd
L4 >

4 Generate: completed with warnings.

Figure 4-9 Generate completed.

file as shown in Figure 4-10, and add the dual_boot.qip file to the project and save.
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5. Click Close and Finish to return to the Quartus window and add the dual_boot gsys into the top
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B dual_boot ud (
Lclk_clk (MAaX10_cLk1_500, // clk. clk
.reset_reset_n (1°b1) S reset.reset_n

Figure 4-10 Add the dual_boot module in the top file.

Secondly, the project needs to be set before the compilation. After adding dual_boot IP successfully,
please set the project mode as Internal Configuration mode, detailed steps are as follows:

1. Choose Assignments > Device to open Device windows shown in Figure 4-11.

(Sh Device X

Device Board

Select the family and device you want to target for compilation.
You can install additional device support with the Install Devices command on the Tools menu.

To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage.

Device family Show in ‘Available devices' list
FEamily: |MAX 10 (DA/DF/DC/SA/SC) 54 Package: FBGA =
Device: |All 82 Pin count: Any =
Target device Core speed grade: Any %
Auto device selected by the Fitter Nameshlier: ‘
(:O) Specific device selected in 'Available devices' list Show advanced devices

Other: n/a Device and Pin Options... l

Available devices:

Name Core Voltage LEs Total 1/0Os GPIOs Memory Bits Embedded multiplier 9-bit *
10M50DAF256C8GES 1.2V 49760 178 178 1677312 288
T0M50DAF25617G 1.2V 49760 178 178 1677312 288
10M50DAF484C6GES 1.2V 49760 360 360 1677312 288
T0M50DAF484C7G 1.2V 49760 360 360 1677312 288 9
ANMEANACAOAFOr 1 anTen  san san 1277319 a00
< >

Migration Devices... 0 migration devices selected

Figure 4-11 Open Device window...

2. Click Device and Pin Opinions to open the Device and Pin Opinions windows, and in the
Configuration tab, Set the Configuration Scheme to Internal Configuration and the
Configuration Mode to Dual Compressed Images. Check the Option of Generate
compressed bitstreams. shown in Figure 4-12.
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(O Device and Pin Options - LEDO Blink

Category:

General
Configuration
Programming Files
Unused Pins
Dual-Purpose Pins
Capacitive Loading
Board Trace Model
1/O Timing

Voltage

Pin Placement
Error Detection CRC
CvP Settings

Partial Reconfiguration

Specify the device configuration scheme and the configuration device.

Configuration mode:

Configuration scheme: |Internal Configuration

Dual Compressed Images (51 2Kbits UFM)

Configuration device

Use configuration device:

Configuration device 1/O voltage:

Auto

Device Options...

[ Force VCCIO to be compatible with configuration 1/0 voltage

VID Operation mode

Configuration pin:

Generate compressed bitstreams

Active serial clock source:

Configuration Pin Options...

Enable input tri-state on active configuration pins in user mode

Description:

Specifies the configuration mode used with the configuration scheme for configuring the device.

OK

Reset

Help

3. Choose OK to return to the Quartus window. In the Processing menu, choose Start
Compilation or click the Play button on the toolbar to compile the project, generate the

new .sof file.

4. Use the same flow to add the Dual Configuration IP into other project LED1_Blink to generate
the new .sof file by internal configuration mode.

Finally, so far, we have successfully obtained two image .sof files for dual boot demo according to
previous steps. This section describes how to generate .pof from .sof files with the internal
configuration mode and program the .pof into configuration flash memory (CFM) through the

JTAG interface.
I. Convert .SOF File to .POF File

1. Choose Convert Programming Files from the File menu of Quartus Prime to open new

Figure 4-12 Set Dual Configuration Mode

window, as shown in Figure 4-13.
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Ok Quartus Prime Standard Edition - C:/T-Core System CD/Dual_boot/LEDO_Blink/LEDO Blink - LEDO_Blink
File Edit View Project Assignments Processing Tools Window Help

New... Ctrl+N PSS DrEED QAVR O
i Open- COHH0 o ledo_blink.v o
Close Ctrl+F4 B er =& i 9 E=
[ New Project Wizard... gg /7
"% Open Project... Ctrl+) 34
. 35 @module LEDO_BT1ink(
Save Project 36
Close Project 37 [//////// Clocks [//////]/
38 input ADC_CLK_10,
H Save Ctrl+S 39 1nput MAX10_CLK1_50,
40 input MAX10_CLK2_50,
Save As... 41
@ Save Al Culsshiftrs |22 {éééé////[KfY /4///////
; ; 44
Eile P rties...
bty 45 e
Create / Update > 2? input [ 3:"8]
EXport.. 48 ///////// LED /////////
I Convert Programming Files... I gg output L3:0]
0 Pageseup. i1 X,
&« Print Preyiew
% Print.. Ctrl+p Colr
Recent Files 4
Recent Projects »
'z Exit AlttFa artitions ~i | The selected partitions alread
al
z Al O A |a A <<Filter>> 88 Find.. | #8Find Next

Figure 4-13 Select Convert Programming Files and click
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Select Programmer Object File (.pof) from the Programming file type field in the dialog of
Convert Programming Files.

Choose Internal Configuration from the Mode filed.
Browse to the target directory from the File name field and specify the name of output file.

Click on the SOF data in the section of Input files to convert, as shown in Figure 4-14.
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[T Convert Programming File - C:/T-Core System CD/Dual_boot/LEDO Blink/LEDO Blink - LEDO_Blink — O X
File Tools Window Search altera.com ®
Specify the input files lo convert and the type of programming file to generale, 4
You can also import input file information from other files and save the conversion setup information created here for
future use,
Conversion setup files
Open Conversion Setup Data... Save Conversion Setup...
Output programming file
Programming file type: I Programmer Object File (pof} ] 2
Options{Bootinfo..  Configuration device: EPCE1® © Mode: E Internal Configuration = |
File name: f dual_bootpof l | |
Advanced... Remote/Local update difference file; NOMNE
[#] create Memary Map File {Generate dual_bootmap)
Create CwP files (Generate dual_bootperiph.pofand dual_bootcore.rbif)
[] create config data RPD (Generate dual_boot_auto.rpd)
Input files to convert
I File/Data area Properties tart Addres | Add Hex Data
SOF Data Page O <auto> Add S0 Page
Add File...
Remove
up
Diown
Properties
v

Figure 4-14 Dialog of Convert Programming Files and setting

6. Click Add File and select the LEDO_blink.sof to be the sof data of Page_0.

7. Click Add Sof Page to add Page_1 and click Add File, Select the LED1_blink.sof to be the .sof
data of Page_1 as shown in Figure 4-15.

8. Click Generate.

These project files can be found in the CD directory: \Demonstrations\Dual_boot\
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¥ Convert Programming File - C/T-Core Systermn CD/Dual_boot/LEDO Blink/LEDO Blink - LEDO_Blink O X
Eile Tools Window Gearchalteracom | @
L T S T - =
future use. o
Conversion setup files
Open Conversion Setup Data... Save Conversion Setup...
Qulpul programming file
Programming file type:  Programmer Object File {pof) z
Options/Bootinfo.. | Configuration device: EPCE1R © Mode: Internal Configuration >
File name: dual_bootpof
Advanced... RemotefLocal update difference file: MOME
ZI Create Memory Map File (Generate dual_bootmap)
CyP files (Generate dual bootperiph.pof and dual boot.corerbf
] create config data RPD (Generate dual_boot_auto.rpd)
Input files to convert
File/Data area Properties tart Addres Add Hex Data
[v SOF Data Page 0 <auto= Add Saf Pape
LEDO_Blink sot 10MSODAF484 —
v SOF Data Page_1 <gulo=> Add File..,
LED1_Blink.sof TOMS0ODAFAE4 B
Remova
ip
Down
Properiies
e

Figure 4-15 Add sof page and sof file
II. Write POF File into the CFM Device

When the conversion of SOF-to-POF file is complete, please follow the steps below to program the
MAX 10 device with the .pof file created in Quartus Prime Programmer.

1. Choose Programmer from the Tools menu and the Chain.cdf window will appear.

sl

Click Add File and then select the dual_boot.pof.

as shown in Figure 4-17.

5. Click Start to program the CFM device.

Click Hardware Setup and then select the DECore[USB-*] as shown in Figure 4-16.

Program the CFM device by clicking the corresponding Program/Configure and Verify box,

Now, you can set the BOOT_SEL by JP2, you will find if you open JP2 (BOOT_SEL = 0), the
LEDO Blink function would show. Power off the board, insert the jumper to JP2 (BOOT_SEL = 1),
then power on, you would find the LED1 Blink function show.
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D Hardware Setup

Hardware Settings

JTAG Settings

hardware setup applies only to the current programmer window.

Select a programming hardware setup to use when programming devices. This programming

Currently selected

hardware:

Available hardware items

T-Core [USBE-1]

Hardware
T-Core

Port
USE-1

Server

Local

| Add Hardware... |

Remove Hardware

Close

Figure 4-16 Hardware setup window

File Edit View

Processing  Tools

window  Help

B Programmer - G:/tmp/ T-core/cd/Demonstration/Dual_boot/LEDO_Blink/LEDC_Blink - LEDO_Blink - [LEDO_Blink....

a bt

Search altera.com

| s, Hardware Setup...| |T-Core [USE-1]

Mode: | JTAG

Progress. ’

|
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[] Enable real-time ISP to allow background programming when available
Wb geart File Device Checksum Usercode Program/ | | Verify | Blank- Examine
e Configure Check
b Stop dual_boot pof 10MS0DAF484 DEDCBBGS 00277542 [l
= i 7 ¥
8 Auto Detect il O
CFMI [ L]
X Delete UFM %] L]
| M AddFile.
¥ Ehange Eile.- s i
[
Lm‘ Save File
I* add Device... e
™ .
|| — R
1 pawn el
10MS50DAF484
TDO
4
W
Figure 4-17 Programmer window with dual_boot.pof file
T-Core 58 www.terasic.com

September 24, 2020




Chapter 5
USB Blasfter Il Cable Feature

The additional feature of T-Core is that it can be used as a USB blaster II to allow users to program
other Intel FPGA boards from the host PC. As shown in Figure 5-1, users can connect to the
external JTAG header (J1) of the T-Core using a flat ribbon cable. Then, use this cable to connect to
other FPGA boards with 2x5 pin JTAG header for JTAG programming(See Figure 5-2).

& = CI0 febede Mo fade
:

CEEEEEEE) (e o

: External JTAG
Header

il

X "0 o o-

Figure 5-2 Using T-Core board as an USB Blaster II cable
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As shown in Figure 5-3, once the T-Core is connected to the JTAG interface of the external FPGA
board, the T-Core board automatically detects the connection (detected the power of the target
board) and switches the JTAG chain from the Intel MAX10 FPGA to the external JTGA header, and
connected to the JTAG interface of the external FPGA board. Implement a USB blaster II function.

External JTAG

Header
TARGET_PWR
P, S g
| External_BLASTER JTAG

a2

Mini USB MAX10_JTAG ( in teI)”
Connector
MAXII <Cmax 10
EPM570GF100 FPGA

@ To external
JTAG interface

Figure 5-3 The auto-switch JTAG circuit of the T-Core board

In addition, users should note that for externally connected JTAG interface, the T-Core can
support I/O standard voltage range from 1.2V to 3.3V. If it is out of this range, it may not be
able to work properly or cause damage.

The following example demonstrates that use the T-Core to connect the JTAG interface of the
Terasic's DE10-Pro Stratix 10 development board and program .sof file into the FPGA via JTAG
interface.

1. Connect the flat ribbon cable to the J1 of the T-Core board, as shown in Figure 5-4. The red line
represents the connection line of pin 1, which needs to be connected to the pin of J1.
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Figure 5-4 The flat ribbon cable connected to the T-Core board

2. Connect the other end of the flat ribbon cable to the 2x5 JTAG header on the DE10-Pro board,
see Figure 5-5.

J2
USB Blaster
Connector

Figure 5-5 The flat ribbon cable connected to the T-Core board
3. Using mini USB cable to connected J2 of the T-Core board and the host PC.
4. Power the DE10-Pro board.

5. Open the Quartus programmer on the host PC, press "Hardware Setup" and select T-Core
[USB-*]. Then press "Auto Detect" and the Stratix 10 FPGA device on the DE10-Pro will
appear in the window, as shown in Figure 5-6.
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& Pragrammer - [ChainZ.cdf]® == o #

Eile Edit View Processing Jools Window Help Cearch Mitel FRGA ﬁ

s Hardware Setup,. | | T-Corne [USB-1] Mode: | ITAG - Progress: ]

Enable real-time ISP to allow background programming when available

-'|'. File Device Checksum Usercode Program/  Verify | Blank-  Examine
= Ooiart
- Configure Check
Wiicion <nones T1SX280HU2 00000000 <nones
M8 Auto Detect
K Delers
1™ Ade File..
[ i ]
ange ke
A
s L
F* add Device. . e .
- TOI : 3
I o ﬁ : :
L .
- i . =
Fepown LTI
15X2B0HUZ
ToO

E

Figure 5-6 Using T-Core board to program the DE10-Pro

6. Select a .sof of the DE10-Pro project and download it. shows the success of the T-Core program
Stratix 10 FPGA, as shown in Figure 5-7.
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< Programmer - [Chainl.cdf]* - o X

Eile Edit View Processing Tools Window Help

i Hardware Setup... | | T-Core [USB-1] | Mode | JTAG -

Enable real-time ISP to allow background programming when available

Y File Device Checksum Usercode Program/  Verify Blank-  Examine
Start Configure Check
W0 C:fUsers/User/Downlo... 1SX280HU2FS0 43634682 43634682 v
B Auto Detect
X Delete
™ addFile...
P“Change File 3 2
w SaveFile
r‘AddDevicem :““f““:
™™ 3
o =
v H .
®pown Sesanannn
1SX280HU2FS0

>~

Figure 5-7 Using T-Core board to program the DE10-Pro
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Additional Information

Revision History

2019.07 V1.0 Initial Version (Preliminary)
®  Modify the SW2 setting description for Figure 3-16.
® Change blaster name from DE-Core to T-Core

2020.01 V1.1

2020.04 V1.2 Modify Figure 2-25
2020.05 V1.3 Update Figure 2-16 and Figure 1-4
2020.09 V14 Modify Figure 5-3

Copyright Statement

Copyright © Terasic Inc. All rights reserved.
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